
 

  

 

 

 

‘How to’ guide for 

applicants 

and 

Troubleshooting manual 

(Enquire system) 

 

 
 

 



Contents 
Part One – ‘How to’ guide for applicants ............................................................................................................... 3 

Creating an Enquire applicant portal account .................................................................................................... 3 

Applying for a Queensland Footy Facilities Fund grant........................................................................................... 3 

Completing the Queensland Footy Facilities Fund application form ...................................................................... 3 

Adding attachments in the Enquire system ................................................................................................... 3 

How do I complete the application form? ..................................................................................................... 3 

Instructions for completing the application form .......................................................................................... 5 

Section 1 – ‘Before you start’ ......................................................................................................................... 5 

Section 2 – ‘Pre-eligibility conditions’ ............................................................................................................ 5 

Section 3 – ‘Organisation details’ .................................................................................................................. 7 

Section 4 – ‘Project details’ ............................................................................................................................ 8 

Section 5 – ‘Need’ .......................................................................................................................................... 9 

Section 6 – ‘Ability to deliver’ ...................................................................................................................... 10 

Section 7 – ‘Declaration’ .............................................................................................................................. 13 

Section 8 – ‘Feedback’ ................................................................................................................................. 13 

Before you submit........................................................................................................................................ 14 

Saving a copy of your application ..................................................................................................................... 15 

What if your organisation is unable to complete an online application? ........................................................ 16 

What if your organisation would like to withdraw an online application? ...................................................... 16 

Part Two – Troubleshooting ................................................................................................................................. 17 

Account log in or registration issues..................................................................................................................... 17 

Authorisation to make the application. ........................................................................................................... 17 

Basic issues at a glance ..................................................................................................................................... 17 

Trouble with attachments or PDFs? ..................................................................................................................... 17 

Having trouble scanning a PDF (EFT form)? ..................................................................................................... 18 

Trouble opening the Excel application attachment? ....................................................................................... 18 

Trouble opening the PDF version of the application? ...................................................................................... 18 

Browser or compatibility issues ............................................................................................................................ 19 

Are you using a mobile or tablet device? ......................................................................................................... 19 

What kind of browser are you using? .............................................................................................................. 20 

Are you unable to view the Enquire website due to compatibility view and rendering errors? ..................... 20 

How do I confirm the internet browser version number? ............................................................................... 21 

Still unable to find the answer to the issue? ........................................................................................................ 24 

Still experiencing technical issues during the application process? ................................................................. 24 

When all else fails? ........................................................................................................................................... 24 



 
 

Part One – ‘How to’ guide for applicants 

 
Creating an Enquire applicant portal account 
 

Sport and Recreation has developed the Grant Registration Portal (GRP) to enhance its grants 
management system (Enquire), making it faster and easier to use, ensuring ongoing security of all 
information and speeding up payments. 

To submit an online application for the Queensland Footy Facilities Fund program, you will need to set 
up an account in the Enquire system by creating an applicant portal account. This account can then be 
used by yourself or your organisation to apply for grants offered by Sport and Recreation. To register 
an account, go to the ‘New Sport and Recreation Grant Registration Portal’ website for guidance. 
Please note a desktop computer or laptop is required to register in the Grant Registration Portal (GRP). 
The GRP does not currently support mobile and tablet devices. 
 
Note – the Enquire system and Grant Registration Portal is a separate system to the Get Started 
Vouchers program (QGrants). 

Applying for a Queensland Footy Facilities Fund grant 
Once you’ve created an account in the Grant Registration Portal you can begin your application. 
Once you’ve logged in you may select the grant and round you’d like to apply for, this will take you to 
the Queensland Footy Facilities Fund page.  

Completing the Queensland Footy Facilities Fund application form  
 The following information will assist you as you complete the online application.  

Adding attachments in the Enquire system 
As part of completing your application form for the Queensland Footy Facilities Fund program you will 
also be required to scan documents and upload them. The Enquire system will take any kind of 
attachment that a computer recognises as a file. This will include documents, spreadsheets, and 
images.  

The system will not accept any files that are over the 20MB limit, so large files may need to be 
scanned in two parts.    

How do I complete the application form? 

 Select the Queensland Footy Facilities Fund program from the ‘Available Rounds’ page. 

 

 Read the relevant program information (guidelines). 

Guidelines reference:  
6.0 Who is eligible to 
apply? 

Guidelines 
reference: 
Appendix 2 
Online application 
form checklist  

https://www.qld.gov.au/recreation/sports/funding/grants-portal/


 

Click ‘Begin Application’.  

 

Please enter your ‘login details’. 

 

 

 If you have already started an application, the following will pop up if you click ‘begin 
application’. 

 

 



To access an application that you have already commenced: 

Click on ‘My Applications’ and select appropriate application. 

 

Instructions for completing the application form  
 Read the ‘Instructions on using the form’ before commencing the application.  

 

It is possible to partially fill in the application and complete it later. This is done by clicking the 
‘Save All & Exit’ button. When you log back in you can select the same application under the ‘My 
Applications’ tab.  

Note: Once you have submitted your application it cannot be changed.  

When you have completed the application, and you are sure all details are correct, click ‘Submit’ to 
complete the application.  

You can view your application at a later date by clicking ‘My Applications’. You may also create a 
PDF of your application at any point by clicking the ‘Download’ button at the top of your application. 

Section 1 – ‘Before you start’ 
 Ensure you read and check that you meet the conditions under the ‘Before you start’ section. 

 

Section 2 – ‘Pre-eligibility conditions’ 

 Click on the ‘Edit’ icon to complete the ‘Eligibility’ sections.  

Guidelines reference:  
6.0 Who is eligible to 
apply? 



 

 Select a response to each question to confirm that you are eligible for the program, and then click 
‘Save’.  

 You will also be required to attach documents. To do this, select ‘Choose file’ and then click on 
relevant file. When you see Max 20MB per attachment, this enables you to save more than one 
attachment. 

 Please note that the organisation must be compliant with all requirements to be eligible for the 
program.  Organisations will be deemed ineligible if they do not meet one or more of the eligibility 
requirements. 

 Some sections of the application form have mandatory questions.  If these questions are not 
responded to, you will not be able to save the section.  If you do not have all information 
available, then select cancel, and save the application so you can complete this section at a later 
date (prior to the program closing date). 

 

When you see Max 20MB per attachment, you can save more than one attachment. 



 

 If you have added an incorrect attachment you are able to delete and replace with a new one. 
You will need to click on the edit icon to open the section.  

 

 You will need to select the attachment that is to be replaced. Select choose a file and attach the 
correct attachment. When you press ‘save’ on the section this will remove the ticked attachment.  

 

Section 3 – ‘Organisation details’ 

 Carefully check the prefilled organisation and primary contact details are correct. If these details 
are incorrect you must contact your organisation’s primary contact to amend these before the 
application is submitted.  

 

 Enter the contact details for the main contact for the project  



 

 

Section 4 – ‘Project details’ 

 Enter the project description by clicking the ‘Edit’ icon. The summary should be one or two 
sentences describing your intended project.  

 

 Enter the physical address of the project, and the Lot and Plan of the project location.  Once the 
physical address is completed click ‘Save Address & Validate’. 



 

Click the ‘Project details - Queensland Footy Facilities Fund’.  

 

 Enter the details of the project and click ‘Save’.  
 Note: if your project is (c) replace an existing place/space you will need to provide further details 

and attach evidence. 

 

 Edit the ‘Demographic Information’ by clicking ‘Edit’. 

 

 Enter the target groups that will receive the primary benefits of the project and click ‘Save’. 

 Note: there is an ‘All age groups and genders (i.e. general community)’ response if your project 
does not have specific target group/s. 

 

Section 5 – ‘Need’ 

 Complete the ‘Need’ section by clicking the ‘Edit’ icon, and then ‘Save’.  



 

 You will also be required to attach evidence of consultation, supporting documentation and/or 
planning documentation. Select ‘Choose file’ and click on the relevant file. 

 Click ‘Save’ when complete. 
 

 

Section 6 – ‘Ability to deliver’ 

 Complete the ‘Ability to deliver’ section.  

 



 

 You will be required to click on the ‘Project plan and Project costs’ spreadsheet and save the 
document to your computer.  

 Follow the below instructions for completing the ‘Project plan and Project costs’ spreadsheet and 
how to upload to the ‘Budget attachment’ section and the Project Costs table. 

Note: When opening the excel Project Plan and Project costs spreadsheet, please ‘Enable Content’ 

and then select ‘Yes’ to make the file a trusted document. 

 

 

Complete the Project Plan tab in the budget attachment 

 



Complete the Project Costs tab in the budget attachment

 

 

 Enter in the ‘total project cost’ and total requested from the department’ 

 Attach the ‘Project plan and Project costs’ spreadsheet to the ‘Budget attachment’ section. 

 Attach supporting documenting for financial and/or in-kind contributions and click ‘Save’. 

 

Complete the ‘Ability to deliver – Queensland Footy Facilities Fund’ section by clicking the ‘Edit’ icon, 

answer the questions, attach documents where necessary then click ‘Save’.  



 

Section 7 – ‘Declaration’ 

 

 Read the declaration section and click ‘Edit’ to complete the section.  

 

Select the response and click ‘Save’ to complete the declaration. 

 

 

Section 8 – ‘Feedback’ 

 Provide feedback by clicking the ‘Edit’ icons on the ‘Sport and Recreation Consultation’ and 
‘Feedback’. 



 

 

 

Before you submit 

Please read all the information. If you are sure all details are correct, click ‘Submit Application’ to 
complete the application.  

Note: Once you have submitted your application it cannot be changed.  

 



 

It is possible to partially fill in the application and complete it later. This is done by clicking the ‘Save 

All & Exit’ button. When you log back in you can select the same application under the ‘My 

Applications’ tab.  

You can view your application at a later date by clicking ‘My Applications’. 

 

Saving a copy of your application 
At the end of the application process, you will receive a PDF version of your application, which can 
be printed or saved if you wish. The details will also remain on the Enquire system which you can 
access when you log in. 

 

 

Now that you are registered, just select the ‘Log In’ option when you next use Enquire. 

 



What if your organisation is unable to complete an online application?  
If the organisation does not own or have access to suitable computer systems or the internet to 
complete an online application, contact your nearest Sport and Recreation office. 

 

What if your organisation would like to withdraw an online application?  
If, for some reason, your organisation would like to withdraw your application, you cannot do this via 
the Enquire system. Please contact your nearest Sport and Recreation office to discuss the 
withdrawal. Arrangements will then be made to have the application removed from the Enquire 
system



 
 

Part Two – Troubleshooting  

Account log in or registration issues 

Authorisation to make the application. 
Make sure you are authorised to complete the application form on behalf of your 
organisation.  

Basic issues at a glance  
 Contact the nearest Sport and Recreation office to discuss your project and 

application prior to submitting the online application form. 

 Please contact your regional advisor initially if you need help registering online or 
completing the online application form. 

 Issues with applying online may occur due to restrictions on home/office computers, 
browsers used – further details are provided in this document.  

 Using Firefox and/or Chrome as your browser for the application process ensures 
compatibility.  

 The Enquire system is NOT compatible with mobile or tablet devices. Any online 
applications must be made from a PC. 

 Provide full and accurate project location address.  If using parks, reserves etc., there 
must AT LEAST be a correct street address and suburb. 

 You can copy and paste from a word file into the online application fields for ease of 
data entry. 

 Ensure you save each section of the online application.  

 Some online applications will require the applicant to download and upload 
documents.  If prompted to download a document, make sure you save it on your PC 
along with any information you have added before uploading.  

 Only click ‘Submit’ when your application is completely finalised, as changes cannot 
be made afterwards. Note: There is an option to save a partially completed 
application and return to it later.  

 Colours of the application form online may appear different due to the user’s monitor 
setup. 

Trouble with attachments or PDFs? 

 Be careful saving files on the computer being used. It is recommended the ‘Save As’ 
function is used and the file is saved in a known location.  

 If user clicks ‘Save’ the file may be filed into the temporary files on the computer being 
used 

 Temporary files are located on the c: drive of the computer being used (e.g. 
C:\Users\halema\AppData\Local\Temp) 



 

Having trouble scanning a PDF (EFT form)? 
You will need to scan a copy of the completed and signed EFT form. If you do not have 
access to a scanner at home or your organisation, one may be available through your local 
library. Alternatively, if you have a smartphone you may be able to download a free scanning 
app to scan the EFT form. 

Trouble opening the Excel application attachment?  
Mac Users Version Compatibility (Numbers for Mac) 
Numbers for Mac is compatible with Microsoft Excel. Save numbers spreadsheets as Excel 
files. Further information on compatibility can be found online:  
https://www.apple.com/mac/numbers/compatibility/ 

Microsoft Excel Version Compatibility 
It is recommended that you use Microsoft Excel 2010 or later. Information on your version 
can be found online: https://support.office.com/en-us/article/What-version-of-Office-am-I-
using-932788b8-a3ce-44bf-bb09-e334518b8b19.  

Trouble opening the PDF version of the application?  
At the end of the application process, you will receive a PDF version of your application, which 
can be printed or saved if you wish. The details will also remain on the Enquire system which 
you can access when you log in. There may also be other information in Enquire, such as a 
Facts Sheet that can help you.  These are available in the ‘Help’ section of the portal.  

Out-of-date or incompatible PDF reader? 
Issues opening a PDF may be due to your PDF reader being incompatible, or out of date. 
Adobe Reader version 9 or higher is required by Enquire. You can download the latest version 
of Adobe Reader for free at http://get.adobe.com/reader/. Other Windows based PDF readers 
are not supported. 

 
Is Acrobat JavaScript enabled? 
You can check if this is the problem by doing the following:  

 Open Adobe Reader from the desktop or start-bar menu   

 Click Edit and selecting Preferences  

 Select JavaScript from the Categories and tick the checkbox to Enable Acrobat 
JavaScript  

 Click OK to close the Preferences window  

https://www.apple.com/mac/numbers/compatibility/
https://support.office.com/en-us/article/What-version-of-Office-am-I-using-932788b8-a3ce-44bf-bb09-e334518b8b19
https://support.office.com/en-us/article/What-version-of-Office-am-I-using-932788b8-a3ce-44bf-bb09-e334518b8b19
file:///C:/Users/HansenM1/AppData/Local/Microsoft/Windows/Temporary%20Internet%20Files/Content.Outlook/GZT44ZS7/help.enquire.net.au/srp/%23ClientPortal-Downloads.htm
http://get.adobe.com/reader/


 Close Adobe Reader by clicking File and selecting Exit  

 Re-open the web browser and continue to use Enquire. 

 
Is Adobe Reader set to display PDFs in a web browser?   
You can check if this is the problem by doing the following:  

 Open Adobe Reader from your desktop or start-bar menu 

 Click Edit and selecting Preferences  

 Select Internet from the Categories and tick the checkbox to Display in Read Mode 
by default 

 Click OK to close the Preferences window 

 Close Adobe Reader by clicking File and selecting Exit  

 Re-open the web browser and continue to use Enquire.  

 
Do you have Kapersky Anti-virus software?   
If you have Kapersky anti-virus software, a blank page will be displayed when you attempt to 
open a PDF. Disabling the anti-virus software in this case will not rectify the issue. You will 
need to download a different browser. For example, if you are using Internet Explorer you 
should try to log in to your Enquire account using a different browser, such as Google Chrome. 
You can download Google Chrome for free through the following link:  
https://www.google.com/intl/en_au/chrome/browser/desktop/index.html 

 
Adobe Reader  
The operation of Adobe Reader is affected by certain ‘add-ons’. It is recommended users 
enable Adobe Reader add-ons for the PDF copy of your application to display and function 
correctly.  
 

Disabling virus add-on/s in Internet Explorer  
Go into the Internet Explorer browser and do the following: 

 Select Tools, and then Manage add-ons 

 Select the add-ons that are listed under the Adobe Systems Incorporated heading  

 Enable the add-on/s by selecting Enable (for one add-on), or Enable all (for multiple 
add-ons)  

 Select any add-ons that mention anti-virus and then select Disable (for one add-on) 
or Disable all (for multiple add-ons) and then Close. 
 

Disabling virus add-on/s or ‘extensions’ in Google Chrome  
Go into the Google Chrome browser and do the following: 

 In the address bar type chrome://extensions  

 Un-tick Enabled next to the anti-virus name (could be multiple entries).  
 

Disabling virus add-on/s in Mozilla Firefox  
Go into the Mozilla Firefox browser and do the following: 

 In the address bar type about:addons  

 Go to the Extensions tab 

 Click the Disable button next to the anti-virus name (could be multiple entries).  

Browser or compatibility issues 

Are you using a mobile or tablet device? 
The Enquire system is NOT compatible with mobile or tablet devices.  Any online applications 
must be made from a PC. 

https://www.google.com/intl/en_au/chrome/browser/desktop/index.html


 

What kind of browser are you using? 
To assist with any queries and to diagnose problems, it may be necessary to confirm what 
internet browser is being used and its version number. Details on how to do this follow.  
Where the Enquire site is not being displayed, first check if you are using a browser from the 
following list (please note: earlier versions of the below should support the Enquire site but 
have not been as thoroughly tested):  

 Google Chrome (Windows, Android and Mac OS X) 

 Mozilla Firefox (Windows and Apple OS X) 

 Microsoft Internet Explorer 8, 9, 10, 11 (Windows) 

 Safari (Apple iOS 7.1.1). 
 

 

You are using Internet Explorer 

 

You are using Google Chrome 

 

You are using Mozilla Firefox 

 

You are using Safari 

 
Enquire may work on Linux or Ubuntu operating systems, but this has not been tested and is 
not supported. 

Are you unable to view the Enquire website due to compatibility view and 
rendering errors? 
To see if there is a compatibility view error, do the following: 

 select Tools at the top of the browser (or if this does not appear, press Alt and T) 

 select Compatibility View Settings 

 in the box under Add this website type in Enquire.net.au  

http://help.enquire.net.au/FAQ-Browser%20Version.htm


 Click Add 

 Click Close. 
 
A rendering error message is an error with Internet Explorer. If this occurs, please download 
Google Chrome at www.google.com/intl/en/chrome/ and use this browser to log into the 
Enquire account. 
 
To assist with queries and diagnose problems with performance, the internet browser 
version number may be required. Follow the instructions below on how to check which 
version is installed.  
 

How do I confirm the internet browser version number? 
 
Internet Explorer 
 Open Internet Explorer. 

 At the top of the Internet Explorer window, select Help and then select About Internet 
Explorer. If the Help option is unavailable, press Alt on your keyboard. 

 

 If you have a more recent version of Internet Explorer, select Tools (cog icon) in the top 
right corner, then select About Internet Explorer. 

 

In the window that appears, the major and update versions will be listed. 

http://www.google.com/intl/en/chrome/
http://help.enquire.net.au/FAQ-Browser.htm


 

More information is available via the Microsoft Support Centre. 

Google Chrome 
 Open Google Chrome. 

 In the top right corner, select either Tools or Settings (wrench or menu icon), and then 
select About Google Chrome. 

 

 The version number will appear in a new window or tab. 

 

More information is available from the Google Support Centre. 

  

http://windows.microsoft.com/en-AU/internet-explorer/which-version-am-i-using/
https://support.google.com/chrome/answer/95414?hl=en-GB


Mozilla Firefox 
 Open Mozilla Firefox. 

 At the top of the Firefox window, select Help and then select About Mozilla Firefox. If the 
Help option is unavailable, press Alt on your keyboard. 

 

 If you have a more recent version, open the menu in the top right hand corner, and then 
select the Help Menu (question mark icon). You will then need to select About Mozilla 
Firefox. 

 

 In the window that appears, the version number will be listed. 

 



More information is available from the Mozilla Firefox Support Centre. 

Safari 
 Open Safari. 

 Select Safari, and then select About Safari. 

 

 In the window that appears, the browser version number will be listed. The first number is 
the major version of Safari, and the number inside the parenthesis is the build number. 

 

Still unable to find the answer to the issue? 
 
Still experiencing technical issues during the application process?  
If you are still experiencing technical issues during the application process, you should Log 
Out and Exit your Enquire account then close all windows. If you only Log Out it may take 
you back to where the technical error occurred.  
 

When all else fails?  
If you are still experiencing issues using Enquire, please email SRSGrants@npsr.qld.gov.au, 
providing the following information:  

 The operating system you are using (i.e., Windows XP, Windows 7, Mac OS X, etc.)  

 The browser and it’s version (click on Help > About in most browsers)  

 Which anti-virus (if any) you are using  

 Time at which the error occurred  

https://support.mozilla.org/en-US/kb/find-what-version-firefox-you-are-using
mailto:SRSGrants@npsr.qld.gov.au


 If you are having issues with any other websites  

 Any error messages you have encountered (please include a screenshot if possible).  


